
 

 

Movavi Slideshow Maker 5

Don't know where to start?
Read these tutorials:

How to remove trial restrictions
Save your video without a watermark and
keep using Slideshow Maker after 7 days.

Make a slideshow
Learn how to make slideshows with music, titles and transitions.

More questions?
Write us an e-mail at support@movavi.com
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Activating Slideshow Maker
When you first start Movavi Slideshow Maker, it will be running in TRIAL MODE. To use the program without trial restrictions,  you will need
to buy the full version and activate Movavi Slideshow Maker.
 
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

 
Step 2: Open the Help menu and select Activate software.

Step 3: Enter your activation key and click Activate.

Activating without Internet access
If the computer you have installed Movavi Slideshow Maker on is not connected to the Internet, you can activate the program via e-mail.
See detailed instructions
 
I bought Movavi Slideshow Maker, but my videos already have a watermark
After you have activated the program, you can open the slideshow project and re-export it without the watermark.
How to export videos
 

Trial restrictions
When you first start your copy of Movavi Slideshow Maker, it will be running in LIMITED TRIAL MODE. In trial mode, you can try out all of
the main features, but the following trial restrictions will apply:
 
TRIAL VERSION FULL VERSION

 Movavi Slideshow Maker will stop working after 7 days  Lifetime license

 A watermark with the words ' trial version' will be added to all
exported videos.

 No annoying watermarks

 Audio files will only be saved halfway.  Free updates
  Discounts on other Movavi products and upgrades
 
To remove the restrictions, buy an activation key and use it to activate Movavi Slideshow Maker.

Getting an activation key
You can get an activation key either from our official website or from any of our partners in your region. Follow the steps below to buy an
activation key from the Movavi website:
 
Step 1: Go to the purchase page
To open the purchase page for Movavi Slideshow Maker:
•  In the Help menu, choose Buy Activation Key, or

https://www.movavi.com/photo-to-dvd-slideshow/buynow.html?asrc=ssm_help
https://www.movavi.com/photo-to-dvd-slideshow/buynow.html?asrc=ssm_help


 

 

•  Follow the link below...

Step 2: Choose a license type
•  If you plan to use Movavi Slideshow Maker at home, click Buy Now on the purchase page to proceed with buying the personal license.
•  If you plan to use Movavi Slideshow Maker at work, in a government institution, or gain profit in any way, click Business on the purchase
page.
 
After that, you will be redirected to an online store depending on your region and the available payment methods. All of our vendor partners
are secure and completely safe.
 
Step 3: Fill in your billing details
1. Choose any of the available payment methods.
2. Fill in the information required on the page.
3. Enter a valid e-mail address. This e-mail will be used to deliver your activation key.
 
Step 4: Get your activation key
After the purchase has been verified, you will receive a letter containing your activation key. Now you can use it to activate the program.
Activation instructions
Activating without Internet access

If you haven't received your activation key within the hour:
•  Check the Spam folder of your mailbox
•  Contact support

Activating without Internet access
When you first start Movavi Slideshow Maker, it will be running in TRIAL MODE. To use the program without trial restrictions,  you will need
to buy the full version and activate Movavi Slideshow Maker.
 
Step 1: Click the button below to buy an activation key. After the purchase is completed, the key will be delivered to you via e-mail.

 
Step 2: Open the Help menu and select Activate software.

Step 3: Enter your activation key and select the Activate offline option. Then, click Activate.

Step 4: In the next window, click Copy and transfer this information to a computer or device with an Internet connection.

https://www.movavi.com/photo-to-dvd-slideshow/buynow.html?asrc=ssm_help
https://www.movavi.com/photo-to-dvd-slideshow/buynow.html?asrc=ssm_help
http://www.movavi.com/support/contact.html
https://www.movavi.com/photo-to-dvd-slideshow/buynow.html?asrc=ssm_help
https://www.movavi.com/photo-to-dvd-slideshow/buynow.html?asrc=ssm_help


 

 

Step 5: When you have access to the Internet, paste the information you copied into a new e-mail and send it to reg@movavi.com. You
should receive a reply within an hour. Copy the registration key from the reply and transfer it to the computer with Movavi Slideshow Maker.

Step 6: Return to the window with offline activation. If you've closed the window, repeat steps 1-3 and enter the same activation key you
used before. Then, paste the registration key into the box and click Activate.

If everything is correct, you will see a successful activation message. Click Finish to complete the activation and close the activation wizard.
 
Once activation is complete, you may be asked to restart the application. If you have entered the key correctly, you should see a message
confirming successful activation. Click OK to complete the activation process and restart the program.
 
If offline activation doesn't work:
•  Check the activation key received at the purchase and try again. Make sure the key is not followed by any other symbols.
•  Make sure the activation key is meant for Movavi Slideshow Maker.
•  Check if you have administrator rights on your computer
•  Close your antivirus software and the firewall.
•  Contact our support team. We will help you get your program activated and answer any question you might have about Movavi products.

Activating and installing packages
Expansion packages are the sets of additional content which include transitions, titles, stickers, backgrounds and music. The packages are
created to help you achieve your creative goals, broaden your freedom of expression and save your time choosing the right artistic tools.
 
Step 1: Acquiring the package

mailto:reg@movavi.com
http://www.movavi.com/support/contact.html


 

 

To use the content expansion packages, open Movavi Slideshow Maker. Switch to the Transitions, Titles or Stickers tab. Then find and
click the Store button at the bottom of the categories list or find the More Effects element in any of the effects categories. You will be
redirected to the Movavi Effects Store web-page to choose and purchase the packages.

Step 2: Making a purchase
On the website, choose and purchase the set you like. After the purchase is processed you will receive an e-mail with an activation key, a link
to download the package, and an instruction on how to install it.
 
Step 3: Installing a package
Click the link you received with the e-mail and download the package. When the downloading is finished, open the package as you normally
would open your project: double-click the file or drag and drop it in the Slideshow Maker. The program will run the installation process. In the
Installing Package window click Install and follow the instructions on the screen.

Step 4: Activating a package
Copy the activation key from your e-mail and Paste it in the in the Activating Package window and click Activate.

 
Wait until the installation is finished. The new elements will appear in the corresponding categories of the Slideshow Maker. The categories
with the new elements will have a blue dot on them and the elements will be marked with the NEW label.



 

 

Cannot install or activate the package? Make sure that:
•  The Slideshow Maker you have installed on your system supports the packages;
•  You use the key that was sent to you after the purchase of a package and there are no additional symbols after the key;
•  You have enough free disk space to install the package.
In this guide, you will learn how to turn your photo albums into awesome slideshows complete with music and transitions. Creating a
slideshow is easy as 1-2-3 using the built-in Slideshow Wizard. Follow the instructions below to open the wizard and start making your own
slideshow.
 
Create a new slideshow
•  On the welcome screen, click Slideshow wizard to open the six-step slideshow wizard.
•  Or open the File menu and choose New Slideshow.

Step 1: Add files
On the Files tab of the Wizard, add the videos and photos that you want to see in your video.
•  Click +Files to add several files from one folder,
•  Click +Folders to add the entire contents of one or more folders,
•  Or drag and drop the files onto the Wizard window.
Learn more – Step 1: Add photos

The files you've added will appear below. You may need to wait a couple minutes for all the files to load.
•  To change the order of the files, simply drag their thumbnails with your mouse.

•  To remove files from the video, click the cross icon  in the upper right-hand corner of each file, or select the files you want to delete and
click the Bin button above the list.



 

 

Step 2: Choose a theme
Click Next or the Theme tab at the top to proceed to the next step. You can choose a preset of transitions, titles and music on a number of
themes and jump straight to the Preview step. To add music and transitions of your choice, click No theme and then proceed to the next
step.
Learn more – Step 2: Select a theme

Step 3: Add music
Click Next or the Music tab at the top to proceed to the next step. Here you can choose music to play along with the video. You can add your
own audio files or use any of the provided audio clips listed in the left-hand column. These audio tracks are royalty-free so you can upload
these videos to YouTube and other services.
 
•  To use one of the built-in tracks, click the + button. 
•  To add your own audio file, click the +Music button at the top and select the audio track, or simply drag the file onto the Wizard window.
Learn more – Step 3: Add music

Step 4: Add transitions
Click Next or the Transitions tab to move to the next step. Choose among the given types of transitions.
Learn more – Step 4: Add transitions



 

 

Step 5: Preview and adjust your video
You're almost done! Click Next or the Preview tab at the top to proceed. If you've added a lot of videos, you may have to wait up to a couple
minutes while the Wizard does its magic. You can then preview the video and make some adjustments to get it just right.

Video length
By default, the video will be just as long as the background audio. To change the length, deselect the Fit to music length option and use the
slider to set how long you want the video to be. If you opt for a shorter video, some clips may not appear in the end result.
 
Black bars removal
If the files in your slideshow are of different resolution than the project
If the resolution of the project and the files in your slideshow are different, black bars will appear. You can remove them by checking the Fit
to frame option – the image resolution will be automatically fitted to the frame size.
Learn more about frame size
 
Volume balance
The volume balance slider determines what kind of sounds you can hear in the video. Move the slider to the left side to hear more of
the video sounds (such as speech and ambient sounds), or move the slider to the right to make the video's sound quieter and raise the
background music volume.
 
Step 6: Save your slideshow
When you're done, click Export in the bottom right-hand corner of the window.
•  To save the slideshow as a video file, pick a video format and click Start.
•  If you want to share the video straight to YouTube or Google Drive, switch to the Share on the web tab. There, sign in to your YouTube or
Google Drive account, fill in the information and click Start to save and upload the video.
 



 

 

 
Save the video – choose this option to save the result as a video file.
Continue editing – this will close the wizard and let you add finishing touches in full mode. After you're finished, you can always click the
big green Export button at the bottom to save the result.
Share on the web – choose this option to save a video file and upload it to YouTube or Google Drive right away.

To save the video, name your project, chose the format and a destination folder where you want to save your video. If you want to upload
your video to YouTube or Google Drive, sign in your account and fill in the information about the video. Then click Start and wait a few
moments until your video is available on the service.
 
Learn more:
Exporting videos
Uploading videos online

Step 1: Add photos
Step 1: Add files
In the first step of the Slideshow Wizard, click +Files to open individual images, or click +Folders to add entire folders to your slideshow. An
Windows Explorer window will open. Choose the files or folders that you want to add.



 

 

Step 2: Reorder your slides
The slides will appear in the same order as you have added them. To rearrange the slides, simply click and drag them with your mouse to the
necessary position.

Step 3: Remove unwanted photos
•  To remove one photo, hover your mouse pointer over it and click the trash can button that appears on top of it.
•  To remove several photos, select them in the list and click the trash can button beneath the slide list.

Next step: Selecting a theme
Step 2: Select a theme

Step 1: Switch to the Themes tab
On the top of the Slideshow Wizard, click the Themes tab to proceed to selecting a theme for your video. Themes are different in their set of
transitions, music and titles. You can choose from a number of topics that your video might fit in. A premade theme will let you skip the steps
of choosing the music and transitions and proceed straight to the Preview step.

Step 2: Select a theme
1. Click a theme to download it, if it is not installed on your computer yet.
2. Watch a preview to see what music, transitions and titles the preset contains.
3. Click a theme you like and then click Next to proceed to the next step. To add music and transitions of your choice, select No Theme
option.
 



 

 

Next step: Adding music
Step 3: Add music

Step 1: Switch to the Music tab
On the top of the Slideshow Wizard, click the Music tab to proceed to adding music.

Step 2: Add music
To add music, click the +Music button and choose the audio files you want to use. If you don't have a suitable audio file, listen to the sample
audio from the lists. Click the Add icon near the track. You can add more than one track.

Delete the track you don't need by clicking the cross icon.

Next step: Adding transitions
Step 4: Add transitions

Using transitions, you can join your photos with cool animations.
 
Step 1: Switch to the Transitions tab
On the top of the Slideshow Wizard, click Transitions to proceed to choosing transitions for your slideshow.



 

 

Step 2: Choose transitions style
You will see a list of transition styles. Click on the one you like to choose that style. You can watch the transitions in the next Preview tab.
 
Next step: Slideshow preview

Step 5: Slideshow preview
On this tab preview the slideshow and make some adjustments in it.
 
Step 1: Switch to the Preview tab
On the top of the Slideshow Wizard switch to the Preview tab.

Step 2: Make adjustments
Titles
Titles will help you add text to the slideshow. Opening titles appear at the beginning of your video, end titles finish it. Default titles that go
with the "No theme" option allow adding two lines of text. Themes include titles of different form, so their design and space available for text
differ.
 
Video length
By default, the video will be just as long as the background audio. To change the length, deselect the Fit to music length option and use the
slider to set how long you want the video to be. If you opt for a shorter video, some clips may not appear in the end result.
 
Black bars removal
If the resolution of the images in your slideshow differ from the project's resolution, black bars will appear on the sides of the frame. You can
remove them by checking the Fit to frame option – the image resolution will be automatically fitted to the frame size.
Learn more about frame size
 
Volume balance
The volume balance slider determines what kind of sounds you can hear in the video. Move the slider to the left side to hear more of
the video sounds (such as speech and ambient sounds), or move the slider to the right to make the video's sound quieter and raise the
background music volume.
 
Step 3: Watch the final video
Watch your slideshow in the player window. Use Play/Pause and the rewind buttons or the rewind slider above. If you want to make changes
in your video, you can go back to previous tabs and add more files or delete them, change the audio track or the transitions style.
 
Next step: Saving slideshow

Step 6: Save your slideshow
Step 1: Switch to the Export tab
In the top right-hand corner of the window, click Export. The export settings window will open.



 

 

Step 2: Choose export option
In the Export window, open the list at the top and choose a format for saving your slideshow.
Save the video – choose this option to save the result as a video file.

Continue editing – this will close the wizard and let you add finishing touches in full mode. After you're finished, you can always click the
big green Export button at the bottom to save the result.
Share on the web – choose this option to save a video file and upload it to YouTube or Google Drive right away.
 
See also: Exporting videos

Making a slideshow in full mode
Jump to:

Creating project | Adding files | Cutting clips | Editing clips | Filters | Transitions | Titles | Saving the video
 
Besides using the wizard, you can also make your own slideshow from scratch by arranging your photos on the Timeline.
 
Step 1: Create a new project
When you open Slideshow Maker, you will see a welcome screen. Click Create project in full feature mode to start making a video
slideshow.
Learn more about projects



 

 

Step 2: Add photos, videos, and music
On the Import tab, click Add Media Files to choose the images, music, and videos you'll be using.
 

Learn more: Adding files | Recording video | Recording audio | Using built-in media

When you open the files, they will be placed on the Timeline: photos and videos on the video track, and audio clips on the audio track. To
rearrange the clips, simply drag them to the necessary position with the mouse.
 

Learn more: Using the Timeline | Working with video and images | Working with audio

Step 3: Cut videos
1. Select the clip that you want to split.
2. Move the position marker onto the moment where you want to cut the clip. You can move the position marker both in the player or on the
Timeline.
3. Click the scissors button on the toolbar to split the video into two parts.

Learn more: Cutting video | Cutting audio



 

 

Step 4: Edit and enhance clips
Select the clip you want to edit and use the buttons on the toolbar to perform basic editing.

Learn more: Rotating clips | Cropping clips | Enhancing colors | Video properties | Audio properties
Step 5: Add filters
Filters can help you change the colors in your photos and videos or add an artistic touch. To apply a filter:
 
1. Click the Filters button to open the filter library. To preview a filter effect, click on its thumbnail.

2. Drag the filter's thumbnail down onto a clip on the Timeline to apply it. A star icon  will appear on the clip.
Learn more about filters

Step 6: Join clips with transitions
1. Click the Transitions button on the left to open the list of transition styles that you can use to join clips.
2. Pick a transition you like and then drag it between two clips on the Timeline.
Learn more about transitions



 

 

Step 7: Add text titles
Use titles and callouts to annotate what's happening on the screen.
1. Click the Titles tab to open the list of available text styles.
2. Find a title style that you like and drag it onto the uppermost track of the Timeline.
3. After you've placed the title clip onto the Timeline, double-click the clip and edit the text in the player. You can use the panel above the
player to change the text style and color.

 
If you want to add arrows and shapes to your video, go to the Callouts tab and drag a shape onto the same track as the titles.

Learn more: Adding titles | Adding callouts
 

Step 8: Export the finished video
When you're finished with your slideshow, it's time to save it in a format that can be viewed in any video player.
 
1. Click the Export button to open the exporting options.
2. In the Export window, choose a format you want to save the video in, and name your slideshow.
3. Finally, click Start to begin processing the video. Your video slideshow will be ready in a few minutes.
Learn more about saving your video

Tip: Make sure to save your work once in a while: choose Save from the File menu to save the project so that you can access it later.



 

 

Having trouble with something?  E-mail us and we'll help you out! Our e-mail: support@movavi.com
Creating and managing projects

A Movavi Slideshow Maker project is a file in the *.meps format that contains your work on creating a video. A project stores the locations of
each media file used in the project, as well as the edits, special effects, and settings that you use as you make your slideshow.
 
Creating a project
To create a new project, open the File menu and choose New Project. Then, choose New Slideshow if you want to make a quick
slideshow, or click New Project if you want to use the advanced features.
Creating projects
 
Saving projects
To avoid losing your editing progress, make sure to save your project every once in a while. To save a project, open the File menu and
choose Save Project.
Saving projects
 
Opening projects
To open a previous project, open the File menu and choose Open. Then, find the project file and continue working on your movie.
Learn how to open projects
 
Media use
When you add files to a project, Movavi Slideshow Maker uses the original file for reference as you edit the movie. To save your disk space,
Movavi Slideshow Maker does not make copies of the files, but rather remembers the location and name of the original file, so if you move or
delete the files, they will also disappear from the project.
Learn how to find missing files
 
Because all of your editing work is done in the project, your original files are not edited in any way, and you do not need to make reserve
copies.
 
How can I play my project?
Project files cannot be viewed in a regular video player, but can only be opened with Movavi Slideshow Maker. To view the finished work in a
player, you need to first export your movie to a common video format.
Learn how to export your project

Creating a project
Creating a project
On launching the Slideshow Maker: select Slideshow Wizard to make a quick slideshow. If you want to make the video yourself, click
Create a movie in manual mode.

If you have already chosen the option to create a project in full mode, then open the File menu, choose New Project and repeat the actions
above.

mailto:support@movavi.com


 

 

That's it! You can now start creating your slideshow.
 

See also:
Saving your work
Project settings
Exporting your movie

Saving projects
A project stores all the work on your movie or slideshow. You can save the project for finishing your work later, or restore your work if you
need to edit something after you've finished.
 
Saving the project
1. Open the File menu and choose Save Project.
2. You will be asked to enter a name for the project. Your project files should be stored in the "\My Videos\Movavi Slideshow Maker\Projects"
folder of your user. 
3. Click Save to confirm saving.
 
You can open this project later to continue working on it.

Saving portable project
A portable project is a kind of project that contains all the media files that comprise it. Since the program does not create copies of the files
and only refers to their location on the disk, the project will only work properly on another computer if all the media files are present there as
well. With the portable project saving option, you don't have to collect all the files manually.
1. Open the File menu and choose Save Portable Project
2. Set a path for your project folder to be saved to and click Save.
3. Then transfer the project folder to another computer with Movavi Slideshow Maker installed.
 
How to change where projects are saved
1. Open the Settings menu and choose Preferences.
2. Click the Files tab.
3. Find the Save project files to box and click the button next to it to choose a different folder for storing your projects.
4. Select the folder you want to use and click Select Folder. 



 

 

See also:
Finding missing files
Project settings
Exporting videos

Opening projects
Open a project to continue working on your video.
 
Where are my projects located?
By default, your projects are saved to "\Videos\Movavi Slideshow Maker\Projects", but you can save your projects anywhere else you like.
 
How to open a project
A: Find your project in Windows Explorer and drag it onto the Slideshow Maker window.
 
B: Find your project in Windows Explorer and double-click it to open in the Editor.
 
C: Click Open Project on the welcome screen. Then, locate the project file in the Windows Explorer box and click Open.
 
D: Open the File menu and choose Open Project. Then, locate the project file in the Windows Explorer box and click Open.

Restoring work from an autosave
If your computer malfunctions and you cannot save the project, some of your work may be restored using an autosave file. Simply rename
the "autosave.meps" file and open in in Slideshow Maker to continue working on your project.

Media use
When you open a previously created project, you may see a message saying that a file is missing from the project. This may happen if one
of the files used in the project has been moved somewhere else or deleted from disk. In this case, click Browse in the message box to find
the file in its new location, or click Skip to open the project without the missing file. We recommend that you copy all the files to your hard
drive before editing.



 

 

Transferring the project to another computer
If you need to work on your project on another computer, you might want to transfer it. To make this transition easy and not to lose any
important files, use Save Portable Project option. This feature will automatically gather the project and the media files used in it in one
folder. Now you can move the folder to another computer that also has a copy of Movavi Slideshow Maker. Open the project and in the new
message dialogue browse for the new path to the files.
Note: If you only transfer the project file and leave the media files out, the project will not contain any files.
Learn more: Saving portable project

See also:
Project settings
Saving projects
Saving portable project

Project settings
How to change the video's resolution

You can adjust the parameters of your video, such as bitrate, video resolution and frame rate. These settings affect the quality and the size of
a final file. You can change them when saving your video or at any other time.
 
Opening project settings
In the Export window click the Advanced button.

Video settings
The video settings apply to all videos and photos used in the project.
 
Resolution
The frame size or resolution determines the videos width and height in pixels. Open the Frame Size list to select from the most common
resolutions. For your convenience, each resolution is marked with its respective aspect ratio. Ideally, the frame size should match the
resolution of the videos and photos you plan to use in your project, and should not exceed the resolution of the largest video. Smaller
resolutions allow you to make the output video smaller and thus save your disc space, however, this will sacrifice some video quality due to
downscaling.
 

Frame Size Aspect Ratio
320x240 4:3
640x480 4:3

1280x720 16:9
1280x960 4:3

1920x1080 16:9
1920x1440 4:3
3840х2160 16:9

4096х2160 256:135

Aspect ratio
The aspect ratio is the ratio of the video or photo's width to its height. The most commonly used aspect ratios are 4:3, used generally for
analog TV and in many old movies, and 16:9, the standard resolution for widescreen digital video.



 

 

A relative comparison of aspect ratios
 

When you add videos and photos to the project, they will be scaled to fit the specified frame size. If you add media files with an aspect ratio
different from that of the project, you may see black bars appear on the sides of the video. Furthermore, if you add low-quality videos to a
project set up to a high resolution (frame size), the small video may be stretched to fit the frame and thus may appear pixellized. For best
results, we recommend setting the frame size and aspect ratio to match all or most of the videos and photos you are planning to use.

 
Examples of black bars appearing when importing videos with a different aspect ratio.

 
If you cannot find the necessary frame size in the list, you can manually enter the width and height into the respective boxes of the Project
Settings window. Note the button with the link icon to the right of the boxes. It allows you to maintain existing proportions when entering new

values:   – the proportions are constrained, allowing you to set a larger or smaller frame size without changing the aspect ratio;  – you
can freely enter the width and height with any proportions. Simply click this button to toggle the two states.
 
Frame rate
Frame rate or FPS defines the frequency at which frames appear on a display per second. Frame rate affects the smoothness of the video
being played. Standard frame rate in most types of videos is 24-30 frames per second. The video plays smoother at a higher value, but the
file size rises as well.
 
Bitrate
Bitrate is the amount of digital information contained in one second of a media file. It is measured in kilobits per second (Kbps). You can
control the output file size by changing the bitrate value. There are three types of bitrate available in the video editor:
Auto bitrate (CBR) is a constant value set by the program and calculated according to other already set quality options such as video
codec, resolution and frame rate.
Constant bitrate (custom CBR) is a constant manually entered value which is then used to process the entire video. This type of bitrate
allows to predict the size of a final media file.
Variable bitrate (VBR) is an automatically picked value that is set within the set quality requirements for the video. VBR will adjust to the
image using the optimal values to save the quality: lower values for a static image and higher values for a more dynamic one. But in this
case it is impossible to predict the output file size.
 
Audio settings
Sample rate
The sample rate affects the quality of digital sound, and defines the maximum frequencies that an audio stream can contain. The default
sample rate is set to 44100 Hz, which exceeds the maximum frequencies of human hearing and is used to record Audio CDs and most
music tracks.
 
Channels
Stereo sound contains two channels and has the capacity to convey the relative location of sound sources, which makes it best for recording
music; mono sound has only one channel and produces sound without differentiating left and right channels. Stereo is the generally
preferred number of channels, however, some mobile devices record sound only in mono mode.
Surround sound (5.1) has the capacity to produce sound using six channels (usually 5 speakers and a subwoofer), which allows it to create
the so called participation effect. This technology is often used in home cinema systems, as well as in some game consoles and PCs.
 

See also:
Creating a project
Saving and opening projects

Adding media files
To begin working on your video project, you will first need to add some media files to the Editor.
 
Step 1: Open the Import tab
The Import tab is the first one you see when you start a new project. To open the Import tab, click the very first button in the upper left-hand
corner of the window.  



 

 

Step 2: Go to the My files section
In the left part of the Import tab, you can switch between adding your own media files or using built-in clips. Click on My files to show file
import options.

Step 3: Open files
1. Click Add Media Files.
2. A Windows Explorer dialog box will open. Locate your files or folders and click Open.
 
If you want to add the entire contents of one or several folders, click Add Folder, select the folder(s) you want to use and then click Select
Folder to add the files.

Step 4: Arrange the files



 

 

Once you've added the files, they will appear on the Timeline at the bottom of the window. The Timeline allows you to arrange the clips in
the order you want. The clips' position relative to the time ruler at the top of the Timeline determines when it will appear in the finished video.
To reorder the clips, select the clips you want to move and then drag them to the new position on the Timeline.
Learn about using the Timeline

Moving a clip on the Timeline

See also:
Working with video
Working with audio

Using built-in media
Movavi Slideshow Maker comes with an extensive collection of built-in media that you can use in your projects for free.
 
Step 1: Open the Import tab
Click the Import button in the upper left-hand corner to open the media options.

Step 2: Choose a media type
On the left side of the Import tab, you can switch between using your own media files and adding clips from the stock collection.
 
•  Sounds – fun sound effects and audio samples to make your videos more expressive.
 
•  Music – instrumental tracks for your background music.
 
•  Sample video – video clips that you can use as intros, overlays, and animated backgrounds.
 
•  Backgrounds – image backdrops for your titles and transparent clips.
 
•  Intro videos –specifically designed video clips that use visual elements and text and can be edited and customized.



 

 

Step 3: Download media files

You need to download built-in media to use it. If a thumbnail has a download icon , it means the file has not been yet installed to
the category. To download it point the cursor at the media thumbnail. The "Click here to download" message will appear. Click on the
thumbnail. The download will start and a progress bar will appear. When the download is finished, you can use the media file.

You can cancel the download by clicking the Stop icon .

You can also download the whole category at once. To do this, open the tab you need and click the download icon  next to the category
name. All the files in the category will be downloaded.
*If your device has a limited amount of space or running out of it, choose the option where you can download only the media you want to
use.
 
Step 4: Add the clip to your project
To use a stock clip in your project, pick a clip you like and drag it onto the Timeline.
 
•  Drag sample video clips and backgrounds onto the video or overlay track,
 
•  Drag sounds and music onto the audio track. To link a sound clip to a video clip, select it on the Timeline and drag it up, towards the video
track until a line appears between the audio clip and the video clip. Now, when you move the video clip, the sound will stay in sync.



 

 

An error occured while downloading the media files
An error can occur in case if there is no internet access. Check your internet connection and restart the download by clicking on the files on
which the error occured. The clips will be downloaded and stored in your "\My Videos\Movavi Slideshow Maker\Media Content" folder.

Recording video

Follow the steps below to record video from a camera that's connected to your computer.
 
Step 1: Connect the camera you want to capture from to the computer. Make sure that the system recognizes the device and that it is
working correctly.
 
Step 2: On the Import tab of the Slideshow Maker, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, choose the camera you want to use for capture. Then, select the resolution and frame rate. A
larger resolution will be able to retain better quality, however, the video file size will be larger. A higher frame rate is necessary for recording
motion, while static scenes can be captured with a lower frame rate.
 
Step 4: In the Audio capture device box, choose the microphone that you want to record the sound with.

Step 5: (Optional) By default, the recordings will be saved to your Movavi Library folder. If you want to save them somewhere else, click

the folder button  under 'Save files to' and choose a different location.
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file
name template. 
 

Step 7: Click Start Capture to begin recording the video. During capture, you can take snapshots using the camera button  on the right.
 
Step 8: To finish the recording, click Stop Capture. If you need to record more videos, repeat steps 7 and 8.
 
Step 9: When you're done, click Back to editing at the bottom of the window. The captured files will be added to your project's Timeline.
Also, they are saved to disk in case you want to use them later.



 

 

Recording audio
After you've added some videos and photos to the Timeline, you can record audio from a microphone or any other recording device.
 
Step 1: Open audio recording options
On the toolbar, click the microphone button to open audio recording options.

Step 2: Set up recording
1. In the Audio device box, choose the device you want to use.
To record from a microphone: choose your preferred microphone or webcam microphone. If you don't see the device in the list, try
reconnecting it to your computer.
To record audio from the computer: select Stereo Mix from the list. This will allow you to record any music, alerts, or other sounds playing
on your computer.
 
2. (Advanced) In the Audio quality box, choose the sample rate and number of channels that you need.
 
3. Set the volume level you want to use in your project.
 
4. (Optional) Enable voice-over mode if you want to record an audio commentary.

5. On the Timeline, place the progress marker to where you want the recording to begin. You will be able to move the clip later.
 

Step 3: Record sound



 

 

1. When you're ready, click Start Recording.
 
2. The recording will start immediately. The recorded audio will appear on the independent audio track, so it can be moved to any
position in the project. If you have enabled the voice-over mode, you will be given a three-second countdown. The video will start playing
simultaneously with the recording. This way you will be able to use your video as a visual aid as you speak. This recorded audio clip will
appear on the linked audio track.
 
3. When you're done, click Stop Recording.

Importing AVCHD video

Follow the steps below to import previously recorded videos from an AVCHD camera.
 
Step 1: Connect the camera you want to capture from to the computer, and enable USB connection mode on your camera. Make sure that
the system recognizes the device and that it is working correctly.
 
Step 2: On the Import tab of the Slideshow Maker, click Record Video. The recording module will open in a separate window.

Step 3: In the Video capture device box, select your AVCHD camera.



 

 

Step 4: On the left, you will see a list of all clips on the camera storage. Review the files and deselect the ones you don't need.

Step 5: (Optional) After importing, the files will be saved to your Movavi Library folder. If you want to save them somewhere else, click the

folder button  under 'Save files to' and choose a different location. 
 
Step 6: (Optional) If you want to batch rename the files, choose a renaming option from the 'File renaming' box and set up the new file
name template. 
 
Step 7: Click Add files to the Editor to start copying the files. This may take a while depending on the size of the videos.

File information
Find the file's location
To find the location of the clip's original file, right-click on the clip on the Timeline and choose Show in Folder from the menu.

See a clip's media information
To see a clip's media properties, right-click on the clip Timeline and choose File Information from the menu.



 

 

A small File Information window will appear. Here, you can find the resolution, aspect ratio, and other properties of the original file. Knowing
certain information about a clip will allow you to better understand which settings are best for your videos.
 

Previewing clips
Use the player in the upper right-hand part of the window to preview your project.
 
Current position
Your current playback position can be controlled using the position marker under the player and on the Timeline.

For precise positioning:
•  To move in 0.5 second increments, open the Playback menu and choose Skip Forward by 0.5 Seconds (Shift+Ctrl+→) or Skip
Backward by 0.5 Seconds (Shift+Ctrl+←).
•  To move precisely from frame to frame, use the Previous frame (Ctrl+←) and Next frame (Ctrl+→) buttons in the player. This will move the
position marker exactly one frame backward or forward.
•  Use the Scale slider to zoom in on the Timeline to make positioning easier.

Playing the video
1. Move the position marker to where you want to start playback.
2. Click Play or press the Space Bar key. 
3. Click the Pause button or press the Space Bar again to pause playback.



 

 

1 – player position marker
2 – current time
3 – previous frame
4 – play/pause
5 – next frame

6 – aspect ratio of the project
7 – unpin player
8 – view in full screen mode
9 – player volume

 
Arranging clips
By default, media files will appear on the Timeline in the same order in which you've added them. To rearrange the clips, drag them with your
mouse and drop them onto the desired position. To select multiple clips, use Ctrl+click or click and drag to draw a selection on the Timeline.

Working with two monitors
If you have more than one monitor, you might want to detach the player into a separate window to have more room for editing. To do that,
click the Unpin player button under the player:

 
The player will then open in a separate window. When you want to return the player back into the main window, click the Pin player button in
the detached player or close the player window.

Timeline tracks
The Timeline at the bottom of the window is your working area where you can organize and edit the clips that make up your video project.
The Timeline consists of several tracks for different types of media, that are all synchronized against the time scale at the top. You can
imagine the tracks as layers: the uppermost layer appears on top of all others. With the exception of the video track, you can layer several
clips on each of the tracks to make your video more dynamic.



 

 

Adding tracks
With the Timeline that allow work with multiple tracks, you have only three tracks available at the start. To work with several video, audio and
title tracks at the same time:
1. Find a Plus button at the upper left-hand corner of the Timeline.
2. Select the track you want to add and click it.
3. (optional) Customize the Timeline: change the order of the tracks, hide the content of a track and link tracks to the video track or detach
them.

Video track
The video track holds videos, pictures, and the transitions between them. You can also place titles, callouts and stickers on the video track if
you want them to appear against a black background.

Overlay track
You can use the overlay track to show videos and images on top of the main video track. Simply drag the clips from the main video track up
onto the overlay track. Overlay clips are linked to a corresponding clip on the main video track. This way, they will stay in sync even of you
move or cut the video clip.
Learn more: Creating overlays



 

 

Title track
The title track holds all of your text clips, as well as callouts and stickers. Clips on this track are linked to a corresponding clip on the main
video track. You can't use transitions or effects on any of these clips.
Learn more: Titles | Callouts | Stickers

Independent audio track
The independent audio track is the very last track of the Timeline and it contains audio that is not linked to any clips on the video track. This
track is most suitable for background music and clips that don't need to be synchronized to videos. Both audio tracks show waveforms that
visualize the volume throughout the clip, so that you can easily find the quietest and loudest parts. You can also fine-tune the volume using
volume curves.
Learn more: Volume curves

Linked audio track
The linked audio track allows you to link audio clips to videos and images on the video track so that the audio clips stay in sync as you edit
your project. The linked audio clip is hidden by default, but you can link clips by dragging them a little but up, towards the video track until a
blue line appears, connecting the audio and video tracks. If you record audio, the audio clip will also appear on this track.

 
Problem: My audio clip appears on the video track
Solution: Some audio files contain album art, which may sometimes be recognized as the video stream. Therefore, these files may be
placed on the video track. In that case, drag the audio clip down onto the audio track, and delete the album art from the video track if you do
not need it.

Hiding and muting tracks
If you want to see how your project looks without some clips, you can disable separate clips or entire tracks.
 
Hiding clips
To hide a clip from view, right-click the clip and choose Hide Clip from the pop-up menu. The clip will not appear in the player or on the
finished video until you re-enable it.



 

 

Muting clips
To disable a clip's sound, right-click the clip you want to mute and select Mute Clip from the pop-up menu. The clip will not play in the player
or on the finished video.

Disabling tracks
To hide an entire track from view, click the eye icon  to the left of the track you want to hide.
 
To disable the sound for an entire track, click the speaker icon  to the left of the track.

 
Undo actions

How to cancel a previous action

It's okay if you make a mistake or change your mind while editing videos because almost any action can be reversed!
 
•  Click the Undo button on the toolbar or press Ctrl+Z to cancel an action.
•  If you've cancelled an action but want to return to it, click the Redo button or press Ctrl+Y.



 

 

Working with video and images
After you've added some videos and images to your project, they will appear on the video track of the Timeline, where you can move and
arrange them into a movie. Next, it's time to edit and enhance the clips.
 
Cut video clips
On the Timeline, select the clip that you want to cut and move the position marker onto the moment where you want to split the clip. Then,
click the scissors button on the toolbar to split the clip into two parts.

Edit videos and images
Photos and videos aren't always perfect from the beginning. Use the buttons on the toolbar to fix and adjust the clips.
 

Learn more: Rotating video | Cropping video | Color adjustments | Volume | Speed | Image duration | Fades | Video properties

Picture in picture and overlays
To overlay one video or image on top of another, select the clip you want to show on top and drag it up, towards the top of the Timeline to
create an extra overlay track. Then, double-click the upper clip to set up where the overlay will be shown on the video.
Learn more about overlays



 

 

Picture and picture, side by side overlay modes.
 
Removing black bars
Some videos and photos may have black bars around them in the player. This can happen because the clip's proportions are different from
the project, for example, if you add a vertical video. To fix this, you can crop the video or use the special Vertical fill filter.
Learn more about removing black bars
 
Creating freeze frames
A freeze frame is a still shot inserted in the middle of a video for dramatic effect. You can use the freeze frame to emphasize a very fast
movement or pause the action while you give additional information.
Learn more about freeze frames

Before and after adding a freeze frame
Cutting video

Using Movavi Slideshow Maker, you can easily split videos into parts and cut out fragments with the Split tool. You can find it on the toolbar
of the main window, marked with a scissors icon: 

Splitting video into parts
Step 1: Select the clip that you want to split.
Step 2: Move the position marker to the moment where you want to cut the clip.
Step 3: Click the Split button on the toolbar.
Note that if the clip has linked audio, the audio clip will also be split.



 

 

Cutting out fragments
Step 1: Cut the clip at the beginning of the unwanted fragment

1. Select the clip you want to cut.
2. Move the position marker to the beginning of the fragment. Use the Previous Frame and Next Frame buttons on the player to
catch the moment precisely.
3. Click the Split button. The clip will be cut into two parts, with the unwanted fragment at the beginning of the second clip.

 
Step 2: Cut the clip at the end of the fragment

1. Select the second clip the you've just cut off.
2. Move the position marker to the end of the fragment.
3. Click the Split button again. The fragment should now be in a separate clip.
 

Step 3: Delete the unwanted fragment
1. Select the clip with the unwanted fragment.
2. Click the trash can button or press the Delete key to remove this clip. The clip will be removed, and the remaining clips on the
Timeline will move to close the gap.

Trimming videos
If you only need to cut off some parts at the beginning or at the end:
Step 1: Place your mouse pointer over the edge of the clip.
Step 2: Click and drag the edge towards the center of the clip to trim the clip to the desired length.

 
For more precise navigation:
•  Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a
second forward or back.
•  Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+← and Shift
+Ctrl+→.
•  Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+← and Ctrl+→ keyboard
shortcuts.

Rotating photos
Nobody likes vertical videos! But don't worry, in just a few clicks, you can turn any photo or video around without having to crane your neck.
 
Rotating by 90 degrees
1. On the Timeline, select the clip you want to rotate
2. Click the Rotate button on the toolbar to rotate the clip by 90 degrees clockwise. Click the button again to rotate the video more.



 

 

Fixing horizon level
1. On the Timeline, select the clip you want to rotate.
2. Click the Crop button on the toolbar to open the Crop tool above.
3. In the Crop tab, use the Angle slider to slightly rotate the clip inside the frame, until the horizon is level with the guides in the player.

Cropping photos
Cropping a photo or video can help you remove black bars, cut away the edges, or permanently zoom in onto an object inside the frame.
 
Step 1: On the Timeline, select the clip you want to crop.
 
Step 2: Click the Crop button on the toolbar. The Crop tool will open, and a cropping frame will appear inside the player.

Step 3: In the player, set the frame so that the parts you don't want are outside it.



 

 

Use the options in the Crop tool on the left to modify the frame.
 
Angle: use the Angle slider to rotate the crop frame. This way, you can fix the horizon level.

Step 4: Click Apply. A star  icon will appear on the clip once you've applied cropping.
 

Removing crop
To remove Crop or any other effect, click the star  icon on the clip to show the list of applied effects and filters. In the list, select Crop and
click the Remove button to discard the effect.

Color adjustments
If the original videos look bleak and not vibrant enough, you can use the automatic adjustments to make the colors look more vivid. If that
isn't enough, you can always use manual adjustments to correct the colors.
 
Step 1: Select clip
On the Timeline, select the clip that you want to adjust.
 
Step 2: Open color adjustments
On the toolbar, click the color adjustments button to open the adjustments tool.



 

 

Step 3: Use auto adjustments
Select the adjustment options that make the selected clip look nicer. The changes will be applied instantly. The Magic Enhance option will
automatically determine the best brightness and contrast balance.

Step 4: (Optional) Use manual adjustments
Click the Manual Adjustments button to show more color control options. Here, drag the sliders to fix the brightness, saturation, hue, and
other properties. To go back to the simple options, click the Auto Adjustments button underneath the sliders.

Once you have used the adjustments, the clip will be marked with a star icon, denoting applied tools or filters: 

Video properties
To open the clip properties for a video or image, select the clip on the Timeline and click the Clip Properties button on the toolbar.



 

 

The Tools panel will open on the Video tab, where you can edit the following:
 
Volume — Sets the volume of the clip's built-in audio.
Only for video clips with built-in audio.
 
Normalize — Makes the quiet parts of the built-in audio louder.
Only for video clips with built-in audio.
 
Speed — Makes the video play faster or slower.
Only for video clips.
 
Opacity — Affects the visibility of videos and images on the overlay track. Reduce the clip's opacity to make it more transparent.
Only for clips on the overlay track.
 
Duration — Sets the precise length of the image clip.
Only for images.
 
Fade in — The video fades in from black in the time you set. Any built-in audio will also fade in.
For any clips.
 
Fade out — The video fades out to black in the time you set. Any built-in audio will also fade out.
For any clips.

See also:
Audio properties
Video volume
Video speed
Changing image duration
Fading video

Changing image duration
By default, all images will be shown for 4 seconds each. To change the duration:

 
Step 1: On the Timeline, select the image clip that you want to edit.
 
Step 2: Click the Clip Properties button to open the properties for the selected clip.

Step 3: In the Duration box, enter the new length of the image. Use the following format: hours: minutes:seconds:milliseconds. Changes
will be applied instantly.



 

 

You can also change image duration by selecting an image clip on the Timeline and dragging its borders left or right. The longer the clip
appears on the Timeline, the longer it will play in your movie or slideshow.

Video volume
This section explains how to manage the volume of video clips. To change the volume of audio clips, refer to the Volume levels section.
 
Step 1: On the Timeline, select the video that you want to edit.
 
Step 2: Click the Clip Properties button to open the video properties for the selected clip.

Step 3: Drag the Volume slider to set the volume for the selected clips. 100% is the original volume.

•  To mute the clip, click the volume icon to the right: .
 
•  If the clip has a lot of volume peaks, try the Normalize option to raise the volume of quiet parts.

Video speed
With the Speed tool, you can speed up or slow down a video or audio clip. This can be useful if you're working on a music video and you
want the video to match the tempo of the music.
 



 

 

Step 1: On the Timeline, select the clip you want to edit.
•  Note that slowing down videos works best on videos with a frame rate of 60 FPS (frames per second) and above.
•  You can also change the speed of any audio clip.
•  If you modify the speed of a video with built-in audio, the audio speed will also be changed.
 
Step 2: Click the Clip Properties button to open the editing tools for the selected clip.

Step 3: Drag the Speed slider to set the necessary video speed, where 100% is the video's original speed.

The clip's length on the Timeline will change to reflect the new speed. If you've changed video speed, the video clips will be marked with a
star icon:

Fading video
In the editing tools, you can add smooth fades to the beginning or the end of a clip. For videos and images, you can use fading
simultaneously with animated transitions. For audio clips, you can create a smooth crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Click the Clip Properties button on the toolbar. The clip properties will open in the Tools panel above.



 

 

Step 3: Set the fade length using the sliders on the Video tab.
 
Fade in – how long in seconds it will take to fade in to full opacity at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full opacity at the end of the clip.

See also:
Adding transitions
Fading audio

Adding overlays
Overlays are video or image clips that are shown over the main video. You can use these to create a split screen or picture in picture effect,
add a logo or watermark, or insert a short clip without cutting the main video. Also, you can use overlays with the Chroma key tool.
 
Before you start:
You'll need to add both the main video (the video that will be the bottom layer) and the overlay video or image to your project.  You can use
images in PNG format to add transparent logos.
 
Step 1: Place the overlay clip
1. Select the clip that you want to make an overlay and drag it up, towards the top of the Timeline.
2. Drop the clip onto the overlay track, where you want it to be shown relative to the main video track.
Note that a blue line now connects the overlay clip to the main clip. This means that the overlay clip is linked to the main clip: if you move,
cut, or delete the main clip, the overlay clip will also be edited.

Step 2: Edit the overlay
1. Double-click the overlay clip to set it up. An options panel will appear in the player.
2. Open the drop-down box on the overlay panel and choose how you want it to appear on the video: Picture in picture, Side by side, or
Cover.

Picture in picture
This is the default overlay mode. Using picture in picture mode, you can show the overlay video over any part of the screen.



 

 

1. Choose Picture in picture mode from the drop-down box.
2. In the player, move the overlay to where you want it to appear in the frame.
3. To resize the overlay, drag at its corners.
4. Deselecting the Constrain proportions option will allow you to resize the overlay to any proportions, but a drastic change in proportions
may make the overlay look distorted.

Picture in picture overlay
 
Side by side
1. Choose Side by side mode from the drop-down box.
2. Use the buttons on the panel to choose how you want to align the two videos: 

Side by side overlay
Cover
Cover mode can be used for a short insert into the main video without having to cut it. While the main video (and audio!) is playing, the
overlay clip will appear on screen for the duration of the overlay clip.
 
If you want to replace a video's background using the Chroma key effect, use Cover mode to place the foreground on top of the new
background. Learn how to use Chroma key. 

Cover overlay: left - the main clip is hidden; right - Cover with the Chroma Key effect
 
Step 3: Apply the changes
After you've set up the overlay, click the Apply button on the overlay options panel.
 
Step 4: Overlay clip properties
In the Tools panel on the left, set up the overlay's properties:

Volume: if you have several video clips playing simultaneously, you might want to mute one of the clips. To do that, click the mute  button,
or use the slider to lower the volume.
 
Opacity: if you want to make the overlay more transparent, lower its opacity, and the main video track will be seen through it.
 
Fade in / Fade out: while you can't use transitions on the overlay track, you can fade in the clip to make it appear smoothly. Set the slider to
the time it should take for the clip to appear.



 

 

See also:
Replacing video background with Chroma key
Using the Timeline

How to remove black bars
Sometimes, when you use videos of different aspect ratios, or if the project is set up incorrectly, some videos may have black bars around
them. You can remove black bars from videos using one of the ways below.

 
Fill empty spaces
Using a special filter, you can fill the black bars with blurred parts of the video. This allows you to keep the entire video on screen and make it
more pleasant to view.
1. On the Timeline, select the clip with black bars around it.
2. Click the Filters button to open the Filters tab.
3. Find the Vertical fill filter in the Adjustments group and drag it onto the clip.
Learn more about filters

Manual crop
If black bars appear only on one or several clips, you can cut off the edges to make the video fit better inside the frame.
1. On the Timeline, select the clip with black bars around it.
2. On the toolbar, click the Crop button.
3. A frame will appear in the player. Set this frame on the part of the video that you want to keep. Parts that are outside the frame will be cut
off.
4. In the Tools tab on the left, click Apply to accept the changes.
Learn more about crop

Creating a freeze frame
A freeze frame is a single frame of a video that repeats for some time, creating an illusion of pausing the video. You can use freeze frames to
emphasize a moment or create a pause to explain things to the viewer.
 
Step 1: Choose a frame
Move the position marker over the frame of the video that you want to freeze. To skip by precisely one frame at a time, use the Previous
frame and Next frame buttons under the player.



 

 

Step 2: Create freeze frame
Once you're on the right frame, open the Edit menu or right-click on the clip and choose Insert Freeze Frame from the menu.

Step 3: Set duration
By default, a new freeze frame is four seconds long. To change the duration, drag the edges of the clip to make the clip shorter or longer.
Learn about changing image duration

Editing audio
Add audio
To add music or other sounds to your slideshow, click the Add Media Files button on the Import tab.

Learn more about adding audio:
Adding audio files | Recording audio | Extracting audio from video | Using built-in sounds

Audio tracks
When you add audio clips to your project, they will appear on one of the audio tracks at the bottom of the Timeline. There are two types of an
audio track:
 
Linked audio track – each clip on this track is linked to a video clip on the main video track. This means that this clip will always stay
synchronized with this video.
 
Detached audio track – this is the standard video track, where audio clips such as background music will play independently from any other
track.
 
After you add the clips, you can rearrange them with your mouse and cut them just like video clips.



 

 

Learn more:
Cutting audio | Looping audio

Volume
To change a clip's volume, click the Audio Properties button on the toolbar and set the necessary volume in the audio tools section above.

Learn more:
Volume levels | Volume curves | Muting clips

 
Audio properties and adjustments
To enhance and adjust the audio, click the Audio Properties button on the toolbar and scroll down in the audio tools section above.

Learn more:
Audio properties | Fading audio | Equalizer | Noise removal | Audio effects | Beat detection

Adding audio
You can add audio files in much the same way as you add photos and video files.
 
Add files from your hard drive
1. On the Import tab, click Add Media Files to browse for audio files on your computer.
2. A Windows Explorer dialog box will open. Choose the files that you want to use.
3. Click Open. The files will be added onto the audio track of the Timeline.



 

 

Use sample audio clips
If you don't have any suitable audio files, you can use free music tracks and sounds from the Movavi Slideshow Maker audio collection.
1. On the Import tab, click Music if you need a background music track, or click Sounds if you need short audio samples. 
2. Click on a clip to play it. When you've picked a clip, drag it onto the audio track of the Timeline.
Learn more about sounds

Record audio
1. Connect a microphone to your computer.
2. On the Timeline, place the position marker to where you want the recording to start.
3. Click the microphone button on the toolbar to open recording options.
4. Set up your recording device and volume.
5. Click Start Recording and record the audio. When you're finished, click Stop Recording. You'll find your new recording on the Timeline.
Learn more about audio recording

Set start time for audio clips
After you've added the audio files, they will appear on the audio track of the Timeline as blue ribbons. To change when the audio clip starts
playing, drag it along the Timeline, using the ruler at the top for time reference.



 

 

Extracting audio from videos
If you want to use a soundtrack from a movie, you can extract it from a video file and use it in your project. 
 
Step 1: Open video file
On the Import tab, click Add Media Files and choose the video that contains the music you want. The file will be added to the video track of
the Timeline.

Step 2: Trim video
If you don't need the whole video's soundtrack, you can trim away the parts of the video you won't need. It's easier to do this with the video
file, as the video can help you visually find the beginning and end of the fragment you need.
1. Select the video you want to trim.
2. Move the position marker to the beginning of the fragment you want to keep and click the Split button on the toolbar (scissors). You've just
cut off the beginning of the video. 
3. Now, select the second clip and move the position marker to the end of the fragment you need. Click the Split button again, and the
fragment will now be in a separate clip.
4. If you don't need the other fragments, select them on the Timeline and click the trash can button on the toolbar to delete them.

Step 3: Extract the audio
The audio that belongs to a video is shown right underneath it on the video track. To separate it from the video, drag the audio stripe down
onto the audio track. If you don't need the video clip anymore, go ahead and delete it.

You can now work with the extracted audio clip separately.
 



 

 

Step 4: Save the audio (optional)
If you want to save the audio clip for later use, you can export it as an audio file:
1. Click the Export button. The export window will open.
2. In the Export window, switch to the Save Only Audio tab.
3. Select an audio format that you want to save the audio file in.
4. The Save to field shows where on the disk the file will be saved. To change that folder, click Browse and select a new folder.
5. Finally, click Start to save the audio file.
Learn more about saving audio
 

Please respect copyright laws and stay within the boundaries of fair use of copyrighted materials.
Using sounds

You can make your movies more expressive using the built-in sound samples.
 
Step 1: Click the Import button to open the Import tab.
 
Step 2: On the left part of the Import tab, click Sounds to open the sound collection.

Step 3: Click on a sound to play it and pick a sound you like. Drag the sound onto the audio track of the Timeline.

Step 4: (optional) To synchronize the sound with a video clip:
1. Select the sound on the Timeline and drag it up towards the video track.
2. The linked audio track will appear, and a blue line will connect the sound clip to the video track.
3. Adjust the position of the sound clip on the linked audio track so that the line points to where the sound should begin.



 

 

Cutting audio
Splitting audio
1. Select the clip that you want to split.
2. Move the position marker to the point where you want to split the clip.
3. Click the Split button on the toolbar (scissors icon).
The audio clip will now be split into two parts.

Trimming audio
To trim an audio clip from the beginning or from the end, hold your mouse pointer over the left or right edge of the clip and drag it towards the
center. The length of the audio clip on the Timeline reflects the length of the sound.

Cutting out parts
Let's say you want to cut out a fragment from the middle of an audio clip.
1. Place the position marker onto the beginning of the unwanted fragment and click the Split button.
2. Place the position marker onto the end of the unwanted fragment and click the Split button.
3. The fragment is now separated into a clip of its own. Select that clip and click the Remove button. The clip will be removed, and the
remaining clips will be moved up to close the gap.

For more precise navigation:
•  Use the arrow keys to jump to the beginning of the previous or next clip on the Timeline.
•  Open the Playback menu and use the Skip Forward by 0.5 Seconds or Skip Backward by 0.5 Seconds commands to jump half a
second forward or back.
•  Use the keyboard shortcuts to move the position marker half a second back and half a second forward, respectively: Shift+Ctrl+← and Shift
+Ctrl+→.
•  Use the Previous Frame and Next Frame buttons for precise frame-by-frame navigation. You can also use the Ctrl+← and Ctrl+→ keyboard
shortcuts.

Audio properties
To open the properties for any audio, including built-in audio on the video track, select the clip on the Timeline and click the Audio
Properties button on the toolbar.



 

 

The Tools panel will open on the Audio tab, where you can edit the following:
 
Volume — Sets the volume of the clip.
 
Normalize — Makes the quiet parts louder.
 
Speed — Makes the audio play faster or slower.
Changing the speed of built-in audio will also affect its video.
 
Fade in — The audio fades in from complete silence to full volume in the time you set.
Fading built-in audio will also fade the video.
 
Fade out — The audio fades out from full volume to complete silence in the time you set.
Fading built-in audio will also fade the video.

See also:
Video properties
Equalizer
Volume curves

Volume levels
Changing volume levels works the same way for video and audio clips:
 
Step 1: On the Timeline, select the clip that you want to edit. This can be a video or an audio clip on any track.
 
Step 2: Click the Audio Properties button to open the tools for the selected clip.
 
Step 3: Drag the Volume slider to set the necessary level, where 100% is the original volume.

•  To mute the clip, click the Mute  button on the right.
•  If parts of the audio clip are too quiet, select the Normalize option to increase their volume.

Playback volume
Only for previewing
If you need to temporarily change the volume of playback in the editor, without changing the project's volume, click the speaker icon in the
preview area and set the necessary volume level. Please note that this will only affect the volume while previewing the project in Movavi
Slideshow Maker, and will not affect the output file.

Volume curves
If you need more advanced volume control, you can use volume curves on the Timeline to set the volume for precise parts of any audio clip.



 

 

Learn more about volume curves

Audio clip with a volume curve
Volume curves

With volume curves, you can control the volume for each part of the clip and smoothly increase or decrease the volume.

Each clip has its own volume curve that starts out at 100% volume for the entire clip, and two points at its beginning and at the end. The
white line on the image below is the volume curve before you add any points.

Step 1: Set the base level
Drag the white line up or down to the necessary level. The top of the clip is 100% volume and the middle of the clip is 50%.

Step 2: Add a volume point
Points on the audio curve represent the volume peaks and lows. To add a point, right-click on the audio curve and choose Add Volume
Point from the pop-up menu. Next, drag the audio point to the necessary volume level. You'll notice that the surrounding parts also move
with the point to make the transition smoother.
 
Make as many points as you need for each part of the clip where you'd like a peak or a drop in volume.

Step 3: Manage the volume for a part of the clip
To set the volume level for a part of the clip, you'll need at least two points. Create a point at the beginning and at the end of the fragment:

Click and drag the white line between two points to change the volume level for this fragment. 
 
Step 4: Transitions
When you drag a volume point or a fragment, the parts of the curve to the left and right will also move with it.

However, this affects only the closest parts of the curve. To get more control over the behavior of the curve, create more volume points. This
way, only the adjacent parts will be adjusted, leaving the rest of the curve as it was.

 
Fading audio

In the editing tools, you can add smooth fades to the beginning or the end of a clip and create a crossfade effect between songs.
 
Step 1: On the Timeline, select the clip that you want to fade.
 
Step 2: Click the Audio Properties button on the toolbar. The clip properties will open in the Tools panel above.



 

 

Step 3:  Set the fade length using the sliders on the Audio tab.
 
Fade in – how long in seconds it will take to fade in from silence to full volume at the beginning of the clip.
 
Fade out – how long in seconds it will take to fade out from full volume to silence at the end of the clip.

Equalizer
Using the equalizer, you can boost or reduce the levels of specific frequencies.
 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Equalizer.

Step 3: Choose an equalizer preset (optional)



 

 

Step 4: Drag the volume bars to adjust the frequencies to the necessary level.

You can save your own equalizer presets to use them in other projects. Set the volume bars to the right levels and click Save. In the new
window enter a preset name and click OK. The created preset will appear in the presets list.

Noise removal
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Noise
Removal.

Step 3: Use the Noise suppression slider to set the amount of noise you want to remove.
•  Start with low levels and listen to the audio to check if the noise is gone.
•  Don't set the noise suppression too high if there isn't much noise because it can start muting other sounds.



 

 

 
Audio effects

Audio effects can transform the sound of an audio clip.
 
Step 1: Select the audio clip that you want to edit. This can also be a built-in audio clip on the video track.
 
Step 2: Click the Audio Properties button on the toolbar to open the audio tools. There, scroll down in the audio tools and click Audio
Effects.

Step 3: Click the box in the Audio Effects section and choose an audio effect you like.

Removing effects
When you've applied an audio effect to a clip, a star icon will appear on it:

Click on the star to show a list of applied effects. Then, select the effect you don't want and click Remove.



 

 

See also:
Using sounds
Audio properties

Beat detection
To make your movie or slideshow more dynamic, use the Beat Detection audio tool to mark audio beats on the Timeline and then adjust
your movie to the beat of the music.
 
Step 1: On the Timeline, select the music that you want to detect beats for.
 
Step 2:  Click the Audio Properties button to open the audio tools. Then, scroll down and click Beat Detection.

Step 3: In the Beat Detection tool, click Detect Beats. The program will analyze the music and place beat markers on the Timeline.

Step 4: (optional) After the beat markers have been placed, you can modify their tempo. Use the Min time between beat markers slider
to make the beat slower or faster.

Step 5: Adjust your clips to the beat. When you trim or drag clips, they will now snap to the beat markers, making it easy to keep to the
beat.
 
Removing beat markers
•  To remove beat markers for a specific audio clip, right-click the clip on the Timeline and select Remove Beats from the pop-up menu.
 
•  To remove all beat markers from your project, right-click the Timeline ruler and select Remove All Beats from the pop-up menu.

Looping audio
If the music file you've selected doesn't go all the way until the end of your slideshow, you can loop the audio and have the file play over
again until the end of the video.
 
Step 1:  Copy the audio clip. To do that, right-click the audio clip on the Timeline, and choose Copy from the pop-up menu, or use the Ctrl
+C keys.
 
Step 2:  Paste the audio clip onto the Timeline right next to the first clip. The clip will be inserted right after the position marker. Repeat until
the audio length is greater or equal to the video length.
 
Step 3: Now, the audio track may be longer than the video track. To trim the audio, hold your mouse pointer over the right edge of the clip,
and drag the edge to the left, until the end of the audio clip is right under the end of the video clip.



 

 

Hint: If you're using the Slideshow Wizard, the audio is automatically trimmed or looped to fit your project.
 

Filters
Using filters you can alter the mood of the video, make an old movie, overlay cool flying objects, and more.
 
Step 1: Open the Filters tab
Click the Filters button to open the filters collection. Click on a filter's thumbnail to see its preview in the player.

Step 2: Find a filter you like
•  On the left, you will see groups of filters. Click on a group to see the relevant filters.
•  If you're looking for a specific filter, enter its name into the search box under the group list.
•  If you really like a filter, click the heart icon to add it to the Favorites group. 

Step 3: Apply the filter
When you've found a filter you like, drag its thumbnail onto the clip you want to apply the filter to.



 

 

Once you've applied a filter, a star icon will appear on the clip, denoting applied filters and tools.

Clip with an applied filter
Removing filters
1. Click on the star  icon on the clip to see the list of applied filters and tools.
2. In the list, select the filter that you don't want.
3. Click Remove.

Transitions
Transitions are short animations that use geometric shapes and transparency to connect two clips in a creative way.
 
Add a transition
1. Click the Transitions button on the left sidebar to open the list of all transitions.

2. In the list of transitions, pick a style you like and drag-and-drop its icon between two clips on the Timeline.



 

 

A transition icon will appear between the two clips.

Change transition length
By default, each transition will be set at 2 seconds long. To change the transition length:
1. Double-click a transition on the Timeline to open transition properties.
2. In the Transition Properties window, enter the new transition length in the Duration field. The format is seconds:milliseconds. If you want
all transitions that are currently in the project to have the same length, select the Set this duration for all transitions option.
3. Click OK to apply the changes.

Transition mode
In the Transition Properties window you can choose mode of transition. This setting affects what media is used to fill in the missing parts of
the transition:
 
Trimmed content – if you've trimmed the video, the trimmed bits will appear during the transition. If the videos haven't been trimmed, a
freeze frame is shown.
Freeze frame – a static frame is shown during the transition.
Slow motion – the part of the video overlapped by the transition is stretched to fill the entire duration.
 
The default mode is set to Trimmed content. The change of transition mode is more obvious when applied to a video clip rather than to an
image.
 
Add transitions to clips
You can automatically add transitions between all clips in your movie in just a few steps:
1. Click the slideshow button on the toolbar. The Create Slideshow dialog box will open.
2. In the Create Slideshow dialog box, select a transition style that you want to use for all clips. If you want to use different transitions, use
the Random Transitions option in the list of transitions.
3. In the Transition duration box, enter the length that you want to set for all transitions. A transition cannot be longer than the shortest clip
in your project.
4. Click OK to accept the changes.
Creating Slideshows



 

 

Add transitions to all clips
To apply a particular transition to all the clips in the project right-click a transition and select the Add to All Clips option from the pop-up
menu.
 
Remove a transition
To remove a transition from your movie or slideshow, right-click the transition on the Timeline and choose Remove Transition from the pop-
up menu. If you want to delete all the transitions in your project, choose Remove All Transitions.

Titles
Adding text titles to your movie allows you to express your thoughts and supplement the audio with subtitles.
 
Step 1: Go to the Titles tab
On the left-hand side of the window, click the Titles button to view the titles collection. Click on a title style's thumbnail to preview its looks in
the player and choose the titles you want to use.

Step 2: Add a titles clip
To add titles to your project, pick a title style you like and drag its thumbnail onto the title track of the Timeline, right above the video track.
A title track will appear above the video track: drop the titles here, onto the time where you want them to appear. The titles will appear as a
purple ribbon on the Timeline.
 
The beginning of each title clip is linked to a corresponding video clip on the video track. This way, whenever you move or edit the video clip,
its titles will always stay in sync.



 

 

If you already have a titles clip on the Timeline, you can add another clip onto the same timeframe to make them play simultaneously: simply
place one title clip under another.
 
Step 3: Edit titles
When you've added a title clip, it will start out with the default text and looks. Double-click the title's ribbon on the Timeline to show editing
options in the player.
 
Title clip properties

Click the cogwheel icon  at the top of the editing panel to see title clip properties. Here, you can change the duration of the titles and
animation speed (how fast they will appear or disappear).
 
Editing text
1. In the preview, double-click on the text box you want to edit.
 
2. Enter the new text.

3. Click the Font properties  button and select the font style, size, and alignment options for the selected text.

4. Click the Color properties  button and choose a color for the text, and the outline's width and color.
 
5. Drag the text box to where you want to see it on the video.
 
Editing decoration elements
Some titles come with frames, ribbons, and other decorations. To change their color, select the decoration element you want to edit and click

the Color properties  button. Then, click the Decorations color palette and choose the new color.
 
Finally, click Apply to exit editing mode.

Hint: you can move several title elements by selecting them with the cursor or holding the Ctrl key and clicking on the elements you need.

See also:
Adding callouts
Adding a timer

Adding a timer



 

 

Step 1: Open the Titles tab
Click the Titles button on the left sidebar to open the list of available text styles.

Step 2: Add Timer titles
1. Find the "Timer" title style. Use the search bar or click the Basic group to filter the styles.
2. Drag the Timer titles onto the title track of the Timeline. Move the clip along the Timeline until its beginning is where the titles should
appear. To change the length of the timer, drag at the edges of the clip.

Step 3: Edit the timer
1. Double-click the timer clip on the Timeline to edit it. A properties panel will appear over the player.

2. On the Clip properties tab , set the duration and the format of the timer. The format determines which units of time are visible on
the timer: hours (hh), minutes (mm), seconds (ss), and milliseconds (zzz).

3. On the Font properties tab , choose the font and style of the numbers.

4. On the Color properties tab , set the color of the numbers and the background color. To make the background transparent, click
the background color square and set Opacity to 0%.

5. On the Timer tab , enter the starting time into the From box. If you want the timer to count backwards, select the Countdown option.
 
6. In the player, drag the Timer to the necessary location on screen.
 
7. Finally, click Apply to exit editing mode.



 

 

Stickers
You can decorate your video and make it more fun by adding stickers on top of it.
 

Step 1: Open the Sticker collection
Click the Stickers button in the sidebar to open the list of stickers.
•  Click on a sticker's thumbnail to preview it in the player

•  If you really like a sticker, you can click the heart icon  on its thumbnail to add it to your favorites list.
Hint: if you don't see the Stickers button in the sidebar, click the More button at the bottom of the sidebar and select Stickers from the pop-
up list.

Step 2: Add the sticker
Select the sticker's thumbnail and drag it onto the title track of the Timeline. All titles, callouts, and stickers go on the title track.



 

 

Step 3: Edit the sticker
Change length
To change how long a sticker appears on the video, drag the edges of the sticker clip on the Timeline.

Move the sticker
To change the sticker's position on your video, double-click the sticker clip to go into editing mode. In the player, drag by the corner of the
frame around the sticker to change its size, and drag by the center of the frame to move the sticker. To rotate the sticker, click and drag the
white dot at the top of the frame. Click Apply above the player when you're finished.

Frequently asked questions
Can I apply transitions to stickers?
No, you can't. Stickers always appear instantly on top of the video.

Callouts
Using callouts, you can annotate your video with arrows, speech bubbles, icons, and other shapes.

Step 1: Open the Callouts tab
Click the Callouts button on the left sidebar to open the shape collection.
•  Click on a callout icon to see it in action.
•  Callouts are grouped into categories on the left. Use these to find the shapes you need.



 

 

•  If you're looking for a specific callout, type its name into the search box under the list of groups.
Hint: if you can't see the Callouts button, click the More button at the bottom of the sidebar and choose Callouts from the pop-up list.

Step 2: Add callout clip
When you find a style you like, drag it onto the title track at the very top of the Timeline. Place the beginning of the clip where you want the
callout to start appearing. Drag the edges of the callout clip to change its duration.

Note that the clip is linked to the corresponding clip on the main video track with a purple line. This means that the callout clip is
synchronized with the video: when you move or cut the video clip, the callout clip will follow without losing sync.
 
Step 3: Edit the callout
Double-click the callout clip. An editing panel will appear in the player. If the callout consists of several elements, for example, text and a
shape or two shapes, make sure to select the one you want to edit.

 
Position
In the player, drag the callout to where you want it to appear on screen.
 
Clip properties
To change the callout's duration, enter it into the Duration box or drag the edge of the callout clip on the Timeline.
 
Colors

Click the Color properties icon  and choose the color and outline for the selected element.
 
When you're done, click Apply to accept the changes and exit editing mode.



 

 

See also:
Adding titles

Pan and zoom
Using the Pan and Zoom tool, you can control camera movement using two keyframes. Set the beginning zoom and the end zoom using the
frames in the player, and the camera will smoothly move from one frame to the other.
 
Step 1: Open the Pan and Zoom tool
1. On the Timeline, select the clip that you want to zoom.
2. On the left sidebar, click the Pan and Zoom button.
Tip: If you can't see Pan and Zoom button, maximize the window, or click the More button at the bottom and select Pan and Zoom from the
pop-up list.

Step 2: Add pan or zoom keyframes
1. On the Timeline, place the position marker to where you want the zooming to begin.
2. Select one of the zooming methods: Zoom in, Zoom out, or Pan.
Tip: To see how an effect works, select it and click Preview.
3. Click Add.

This will add two zoom keyframes to the clip. Using these keyframes, you can set up when the camera moves from one point to the other.
The camera will move between these two keyframes.



 

 

Step 3: Set up the zoom frames
Now, you can set the zoom level for each keyframe using the frame in the player, and the camera will smoothly move from one frame to the
other.
 
1. To change the starting keyframe, double-click the first point on the clip. Then, use the frame in the player to set the zoom level for the
starting point of the camera movement. 
 
2. To change the ending keyframe, double-click the second point on the clip. Then, use the frame in the player to set the zoom level for the
ending point of the camera movement.

Step 4: Change the keyframe time
•  To change the length of the zoom effect, hold your mouse pointer over a keyframe and move it left or right.
 
•  To move the zooming effect without changing its length or other settings, hold your mouse pointer over the arrow and move it along the clip.
 
Step 5: Add more zooming (optional)
If you want to add more camera movements, repeat steps 2-4 to combine other camera movements in one clip. For example, you can zoom
in on an object, pan across the frame with the same zoom level, and then zoom back out to 100%.

 
Removing zoom
To remove a pan or zoom effect, right-click a keyframe and select Remove All Keyframes to clear all zoom effects from the clip. To remove
just the selected keyframe, select Remove Keyframe.

Chroma key
Replacing a video's background

The Chroma key effect allows you to remove any color from the image or video, leaving the background transparent.
 
Step 1: Add the foreground and background clips
Add the video or image clips that you want to use as the foreground and the background. For the foreground (the clip that you want to
remove the background from), use a clip with a bright, solid background that contrasts with the foreground objects.
 
Step 2: Create an overlay
1. Select the foreground video and move it up, onto the Overlay track.
2. Double-click the foreground video on the Overlay track. The overlay options will appear above the player.
3. To make the foreground video completely cover the background video, select the Cover overlay mode from the list above the player.
4. Click Apply.



 

 

Step 3: Open the Chroma Key tool
1. Select the foreground video on the Overlay track.
2. On the left sidebar, click the Chroma Key button. The Chroma Key options will appear.
Tip: If you don't see the Chroma Key button, click the More button and select Chroma Key in the pop-up list.

Step 4: Set up Chroma Key
1. Once you open the Chroma Key tool, move your mouse cursor over the player and click on the color that you want to remove. The color
you've picked will be made transparent, and the underlying video will now be visible.
Tip: if nothing happens when you click on the player, click the color swatch in the Chroma Key options and then try again.

2. Use the Tolerance slider to set how many similar shades of the selected color should also be removed. Higher values will remove similar
colors to the one you've selected.
3. Use the Noise slider to determine how sharp the object's edges should be.
4. Use the Edges slider to determine how thick the object's edges should be.
5. Use the Opacity slider to set the transparency of the background.
6. Finally, click Apply to accept the changes.



 

 

Chroma key effect
Cropping the video
If the videos you're using for the foreground and background have different aspect ratios, you may end up with black bars along the edges
after applying Chroma key. To fix this, crop the videos to the project's aspect ratio.
How to remove black bars
Cropping videos
 

Exporting videos
When you're done with your project, you'll need to export it as a media file to be able to play it back in media players, mobile devices, and
so on. This section will guide you through the process of exporting your project to a popular video format. If you want to find out more about
other ways of saving videos, see the following guides:
Saving only audio
Saving videos for devices
Saving videos for TVs
Uploading videos online
 
Step 1: Open the Export window
To start saving the video, click the Export button in the bottom right-hand corner of the Editor. The export settings window will open.

Step 2: Choose a format
In the new window choose a format for saving the video in.  Some formats allow you to choose between video codecs. If you don't know
which format to choose, try using MP4 with the H.264 codec. The MP4 format is supported by most platforms and operating systems.
The Estimated File Size field shows how much disc space your file will require after saving. If the file size is too large, you can set a lower
resolution in the Project Settings. At lower resolutions, the file will be significantly smaller, however, the video will lose some quality due to
the limitations of digital data compression. When changing resolutions, we recommend that you keep the same aspect ratio to avoid black
bars around the video or other unwanted distortions.
The GIF format is different from other formats in the list. It allows saving video as a mute animated image, which can then be played in some
image viewing programs or in any web browser.



 

 

Learn more about project settings 

Step 3: Check your project settings
When saving standard video, the video will be exported with the same settings that were set for the project. This way, the output video will
appear exactly as you've seen it in the preview area. If you want to change the resolution, aspect ratio, or other settings, click the Advanced
button to view and edit the project settings. In the settings you can also choose to save a 60 FPS video*.
*The video file will have a frame rate of 60 FPS only if the original video files used in the projects had a frame rate of 60 FPS and above.

Step 4: Select quality (optional)
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate.
This will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small
file size.

Step 5: Choose a destination folder
Name your file and choose a destination folder.
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.



 

 

Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.

Export only audio
This section will guide you through exporting just the audio track of your project.
 
Step 1: Open the Export window
Click the Export button in the bottom right-hand corner of the Editor to open the export settings window.

Step 2: Switch to the Save Audio File tab
In the left hand part of the Export window you will find a number of tabs. Click on the Save Audio File tab.



 

 

Step 3: Choose a format
Select the format you'd like to save the audio in.

While MP3 is the most commonplace format, supported by almost all media players and devices, FLAC format allows you to preserve high
audio quality, albeit taking up considerably more disc space. When choosing an output format, it is important to note the quality of the original
files: due to data compression limitations, digital audio cannot be restructured from very low quality files by saving them as FLAC audio, and
vice versa – high quality files may lose some of that quality when saved to MP3 format which is limited to 320 Kbps.
 
When saving audio from your project, the audio file will retain the same sample rate and channel settings as you have set for your project.
The audio bitrate will be determined from the quality of the original files and from the maximum bitrate for the selected format (for example,
MP3 is limited to 320 Kbps, while FLAC bitrate is not limited).
 
Step 4: Name your file and choose a destination folder
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 5: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes. 

Export for devices
This guide will help you export your video project for playing on mobile phones, tablets, and other devices.
 
Step 1: Open the Export window
In the bottom right hand corner of the Editor, click the Export button to open the export settings window.



 

 

Step 2: Switch to the Save for Devices tab
In the left hand part of the Export window click on the Save for Devices tab.

Step 3: Choose a format
On this tab you will find a number of different types of devices for which you can choose a format. You can choose between devices running
iOS (iPhone, iPad, iPad mini) or Android, Samsung Galaxy S6 and Galaxy S7, Google Nexus 6 and Google Pixel, as well as Playstation and
Xbox consoles. If your device is not on the list, choose Other.

Step 4: Set export quality (optional)
If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher bitrate.
This will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at a small
file size.
In the Advanced section you can view the properties for the output file. Due to the limitations of some devices, the video resolution, audio
quality, and other properties may be changed to adhere to the requirements of the selected device. Estimated File Size will give you a rough
estimate of how much disk space the file will occupy, which may be important if your device is running out of memory.



 

 

Step 5: Name your file and choose a destination folder
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.

Export for TVs
This guide will help you export your video project for playing on Smart TVs.
 
Step 1: Open the Export window
In the bottom right hand corner of the Editor, click the Export button to open the export settings window.

Step 2: Switch to the Save for TVs tab
In the left hand part of the Export window click on the Save for TVs tab.



 

 

Step 3: Choose a format
Choose your TV brand and the necessary resolution. If your TV is not on the list, choose Other 1080p TVs or Other 4K TVs.

Step 4: Set export quality (optional)
Project settings: If you've been using the default project settings, your video's resolution is now 720p. To avoid losing quality when saving to
a larger resolution, open the Advanced window and edit the project settings. There, choose the 1920x1080 resolution for 1080p HDTVs, and
the 3840x2160 resolution for 4K Ultra HD TVs.
 
Quality: If your project is heavy on small details and filters, you can select High or Highest quality to export the finished video with a higher
bitrate. This will increase the output file size but will preserve better quality. For most other projects, Good quality will provide a nice result at
a small file size.

Step 5: Name your file and choose a destination folder
In the 'Save to' field, enter the folder where you would like to store the file. By default, this will be the directory for saving output videos
specified in the preferences. To set a different folder, click the Browse button and choose the folder in the Windows Explorer window, or
enter the path manually into the box. Name your video in the File Name field: the project's name will be filled in for you by default.
 
Step 6: Start exporting
Click the Start button to begin processing the video file. This may take up to a few minutes.



 

 

Uploading videos online
After you finish your video, you can share it to YouTube or Google Drive right from the export window.
 
Step 1: Open the Export window
Click the Export button to open the exporting window.

Step 2: Switch to the Upload online tab
In the left hand part of the Export window click on the Upload to Youtube tab.

Step 3: Choose a service to upload to
On the Upload online tab select the service you would like to upload your videos to: YouTube or Google Drive.



 

 

 
Step 4: Sign in to your account
1. Click Sign in. The authentication page will open in your browser.
2. Sign in to your account and click Allow to let Movavi Slideshow Maker upload videos.

Step 5: Choose a resolution
In the Export window, open the Resolution list and choose a resolution that suits your project.
•  For best results, choose a resolution that is equal to or less than the height of your project. You can find the resolution of the project at the
bottom of the main window, next to Project settings. For example, if your project is 1280x720, choose the 720p resolution.
•  This resolution will be the highest quality available for your video. Lower resolutions will be generated automatically by the website.

Step 6: Fill in the details (YouTube)
1. Fill in the title and description for your video.
2. Add some tags to help users find videos by relevant topics. Separate tags with commas and add a number sign (#) before each one.
3. Choose a category to help viewers find relevant content.
4. Open the Privacy box and choose who you want to see the video:
•  Private – videos can only be seen by you and the users you choose.
•  Public – videos can be seen by and shared with anyone.
•  Unlisted – videos can be seen and shared by anyone with the link.



 

 

Step 6: Fill in the details (Google Drive)
1. Fill in the title for your video.
2. Select a Google Drive folder where you want your video to be uploaded. You can create new folders in your Google Drive storage straight
in the export window.
3. Open the Privacy box and choose who you want to see the video:
•  Private – videos can only be seen by you and the users you choose.
•  Unlisted – videos can be seen and shared by anyone with the link.

 
Step 7: Save and upload the video
1. Before uploading, the video will be saved as a file on your computer. To change where the video file is stored, click Browse and select a
folder.
2. Click Start to begin saving and uploading the video.
 
*YouTube allows users to upload videos up to 15 minutes. To upload longer videos, you need to verify your account.
YouTube help – increasing your upload limit 

 
See also:
Sharing preferences

Program preferences

To open the preferences:
1. Click the Settings menu
2. Select Preferences.
 

https://support.google.com/youtube/answer/71673?hl=en


 

 

The Preferences window will open. The preferences are organized into tabs. Click on a tab to open the relevant options.

When you're done, click OK to close the window and apply the preferences.

See also:
General preferences
File preferences
Acceleration preferences
Sharing preferences

General preferences
Interface Language – to change the interface language, simply select the necessary language from the list and click OK to apply the
changes.
 
Automatically check for updates – select this option and you'll be notified whenever a new version is available. Updates within your
version are absolutely free (e.g. 1.0 to 1.1), while new releases are offered with a hefty discount to registered users.
 
Send anonymous usage stats to Movavi – checking this box will allow the program to send usage statistics to our development team,
enabling us to fix any bugs you may encounter much faster, as well as add new features that you might be missing. The data contains no
personal information, will not be disclosed to third parties and will be used for software improvement purposes only.
Learn more about how we use the statistics
Read our Privacy Policy
 
Use software OpenGL implementation – this option can be useful if your computer doesn't support the necessary OpenGL version and
you see an error message when you start the program.
 
OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can use this option to download and install a
software replacement. Installation will run automatically, but you will need an Internet connection to download the files.
 
If Movavi Slideshow Maker runs without showing an OpenGL error message, this option is not recommended.
Learn more about OpenGL troubleshooting
 
Play notification sound when exporting is finished – when saving a project as a media file, you'll be notified as soon as the process is
completed.

http://www.movavi.com/mip.html
http://www.movavi.com/privacy.html


 

 

File preferences
On the Files tab, you can find the options for storing and saving different kinds of files. You can change any of these folders to a different
location.

 
Save project files to – this folder will by offered by default when saving and opening projects. This folder will also store any autosave files
for new projects. You can use the autosave file to restore your work in case of an error or force close.
 
Save output videos to – this folder will be offered by default when exporting media files.
 
Store audio recordings in – the audio clips that you record in the Editor will be stored as audio files in this folder.
Tip: if you delete these audio files, the audio recordings in the project will also be unavailable.

Changing where the files are stored
Using a different folder might help if you don't have much disk space on your primary drive, or if you want to organize your media files in
another way.

1. Click the button with three dots  next to the folder you want to change.
 
2. A Windows Explorer dialog box will open. Choose the folder you want to save the files to.
 
3. Click Select Folder to use this folder. 

Sharing preferences
On the Sharing tab of the Preferences window, you can manage your social network accounts for uploading videos.
 
To sign in:
1. Click Sign In. The authentication page will open in the browser.



 

 

2. Sign in to your account.
3. On the next page, allow Movavi Slideshow Maker to upload videos to your account.

4. Return to Movavi Slideshow Maker. Your name will be shown in the Preferences window.
 
To sign out or use a different account:
Click Sign Out. After this, you will need to sign in again to upload videos.



 

 

Acceleration preferences
If your computer is equipped with the necessary hardware, these options can help speed up encoding and decoding of media files, allowing
you to save your movies much faster and enjoy smoother performance.

Enable Intel hardware acceleration
•  Accelerates video processing by up to 400% when working with H.264 and MPEG-2 video codecs.
•  This option is only available if your computer is equipped with an Intel processor that supports the Intel HD Graphics™ technology.
 
Enable NVENC hardware acceleration
•  With this option enabled, your NVIDIA graphics card will be used for processing H.264 and MPEG-2 videos and they will be saved up to
50% faster.
•  Because video processing is carried out by the graphics card, your CPU is free for other tasks, ensuring smoother performance in other
programs.
•  This option is only available if your computer is equipped with an NVIDIA graphics card that supports this technology.
 
Fast Track HD Acceleration
Fast Track HD Acceleration provides smooth and fast program running. By enabling HD clips optimization in the Preferences menu you
allow the video editor to create copies of the project files in a smaller size and then use them in the project instead of the original ones. To
enable this feature you need to have free disk space, so the Editor can store and use the copies. Once you finish editing and begin export,
high-quality files will replace all the temporary optimization copies.
 
Troubleshooting
If acceleration options are unavailable:
•  Your computer might not have the right hardware.
•  If you're sure that your hardware meets the requirements, try updating your drivers. You can always find the newest version on the
manufacturer's website: Intel Download Center | NVIDIA Driver Downloads

https://downloadcenter.intel.com/
http://www.nvidia.com/Download/index.aspx?lang=en-us


 

 

Intel HD Graphics is a trademark of Intel Corporation.
NVENC is a trademark of NVIDIA Corporation.
 

Help and support
Didn't find what you were looking for? Need help with a problem? Have a suggestion? Contact our support team and we'll help you right
away.

How to reach us
By e-mail: support@movavi.com
Fill out a support form
We guarantee a response within 3 business days!
 
If you ran into a problem, please describe it in as much detail as possible; any screenshots, log files, or information
about your system will allow us to help you faster.

 
Frequently Asked Questions
How to remove the trial watermark
What are the system requirements for using Movavi Slideshow Maker?
What formats can I save my slideshow in?
More frequently asked questions
 
 

System requirements
Note that Movavi Slideshow Maker may also run on slower machines, however, we cannot guarantee stable performance if the minimum
requirements are not met.
 
 Minimum system requirements Recommended configuration
Operating system Windows XP*/Vista/7/8/10 with latest service packs and patches
Processor Intel, AMD or compatible processor, 1.5

GHz
Intel, AMD or compatible processor, 2.8 GHz
and above

NVIDIA® GeForce™ series 6 or higher, AMD Radeon™ R600 or higher graphics card with
up-to-date drivers
 

Graphics card

Your graphics card must support OpenGL
2.0 and above for the program to work
correctly.

OpenGL 2.1 and above is recommended for
smooth performance

Resolution 1024x768, 32-bit color 1280x1024 or higher
RAM Windows XP – 256 MB

Windows Vista – 512 MB
Windows 7, 8, 10 – 1 GB

Windows XP – 1 GB
Windows Vista, 7,8, 10 – 2 GB

Available disk space 280 MB for installation
2 GB for ongoing operations

Additional space required to save captured
video and export projects.

 Administrator permissions are required for installation
Additional features  Sound card for audio recording and playback
  Intel® hardware acceleration requires a

compatible Intel processor supporting Intel HD
Graphics™ 2nd generation or higher
Learn more

 
Supported formats

Here you can view the list of formats and codecs supported by Movavi Slideshow Maker.
 

 
Video Formats

Format Codec Read Write

3GPP, 3GP2
(*.3gp, *.3g2)

H.263, H.264, MPEG-4

ASF – Advanced Streaming Format
(*.asf)

MPEG-4, VC-1, WMV V7  

AVI – Audio Video Interleave
(*.avi)

H.264, MPEG-4, MJPEG

 H.263, DivX, Xvid, DV, Cinepack,
Fraps, TechSmith, Uncompressed

 

DivX Video
(*.divx)

DivX  

Flash Video
(*.flv)

H.264

 FLV1, H.263, Flash Screen Video  
Flash Video FLV1

mailto:support@movavi.com
https://www.movavi.com/support/contact.html
http://www.movavi.com/support/


 

 

(*.swf)
 MJPEG  
MKV – Matroska
(*.mkv)

H.264, MPEG-4, MJPEG, Theora,
VP9

 DV, Uncompressed  
M2TS – MPEG Transport Stream
(*.m2ts)

H.264

MTS – MPEG Transport Steram
(*.ts, *.mts, *.m2t)

MPEG-2, H.264  

MPEG
(*.mpg)

MPEG-1, MPEG-2

MPEG
(*.mpeg, *.mpe, *.m1v, *.mod, *.tod)

MPEG-1, MPEG-2, H.264  

MPEG-4
(*.mp4)

MPEG-4, H.264

 H.263, MJPEG, ProRes,  

MPEG-4
(*.m4v)

MPEG-4, H.264, H.263, MJPEG,
ProRes

 

MXF – Material eXchange Format
(*.mxf)

MPEG-2, DV  

OGV – Ogg Video
(*.ogv)

Theora

 MPEG-4  
MOV – QuickTime
(*.mov)

H.264, MPEG-4, MJPEG

 AIC, ProRes, Sorenson 1/3, PNG  
QuickTime
(*.qt)

H.264, MPEG-4, AIC, MJPEG,
ProRes, Sorenson 1/3

 

RM – RealMedia
(*.rm, *.rmvb)

Real Video 2/3/4, Cooker  

WebM
(*.webm)

VP8, VP9

 VP7  

WMV – Windows Media Video
(*.wmv)

WMV V8

 WMV V7, WMV9, WMV 9 Screen,
WMV 9 Advanced profile, MPEG-4,
WMV 9.1 Image V2

 

WTV – Windows Recorded TV Show
(*.wtv)

H.264, MPEG-2  

Audio formats

AAC – Advanced Audio Codec
(*.aac)

AAC

AIFF – Audio Interchange File Format
(*.aif, *aiff)

Uncompressed  

APE – Monkey's Audio
(*.ape)

Monkey's Audio  

AU
(*.au, *.snd)

PCM  

FLAC – Free Lossless Audio Codec
(*.flac)

FLAC

MP3 – MPEG-1/2 Audio Layer III
(*.mp3)

MP3

MPEG-4
(*.m4a)

AAC

OGG – Ogg Audio
(*.ogg)

Vorbis

WAV – Waveform Audio File Format
(*.wav)

PCM

 AAC, MP3  
WMA – Windows Media Audio
(*.wma)

WMA 9

 WMA Pro, WMA Voice  
Форматы изображений



 

 

BMP, DPX, GIF, JPEG, PGM, PBM, PPM, PAM, PCX, PNG, PTX, TARGA,
XBM, XWD

 

 
You can view the full list of supported devices on our web-page.
Supported formats

Codec activation
Some video and audio codecs are patented by other companies, and it is required that new users activate the codecs they use to comply
with patent law.
 
How to activate a codec
1. When you open a media file or export your project with one of these codecs, you may see a Codec Activation message.
 
2. Select the Activate other codecs without asking box to activate all codecs automatically in the future. The codecs will be activated
automatically, but an Internet connection is still necessary.
 
3. Click Activate to complete the codec activation.
 
Codec cannot be activated
If you see a codec activation error, make sure that you have a working Internet connection. Without Internet, the codecs cannot be activated
even if you've chosen to activate them automatically. After you've restored the network connection, please restart the application.
 
What kind of data is being sent?
The data we send does not contain any information that can personally identify you. We only receive information about which codecs were
used.

OpenGL troubleshooting
If you see the following message about OpenGL when you open Movavi Slideshow Maker or you've noticed that the player, filters, or
transitions do not work, your computer most likely does not support the necessary version of OpenGL. To run Movavi Slideshow Maker, your
computer needs to support at least OpenGL version 2.0, and version 2.1 is required for smooth performance.

OpenGL is a software interface that manages graphics output. Usually, OpenGL is handled by your graphics card driver. However, some
graphics cards do not support the necessary version of OpenGL. For these graphics cards, you can try the steps below:
 
Step 1: Update your graphics card driver
Sometimes, this issue may occur when something is wrong with the graphics card drivers or they are out of date. Download the driver
installation file from the manufacturer's website and install it following the on-screen instructions.
Detailed instructions on updating the driver
 
It is recommended that you restart the computer after installing driver software. After that, try starting Movavi Slideshow Maker. If you see an
error message again, proceed to the next step.
 
Step 2: Try the software OpenGL implementation
If your graphics card still doesn't support OpenGL 2.1 even after updating the driver, you can use a software alternative:
 
•  In the message you see after starting Movavi Slideshow Maker, select the Download and install software OpenGL implementation box.
 
•  Or, in the main Movavi Slideshow Maker window, open the Settings menu and choose Preferences. There, select the Use software
OpenGL implementation option and click OK.

After that, the software OpenGL package will be automatically downloaded and installed. When the installation is finished, restart Movavi
Slideshow Maker.
 
If these steps haven't helped:
•  Check that your computer meets the minimum system requirements. Your graphics card must support at least OpenGL 2.0.
•  Contact our support team. Provide your graphics card model and list the steps you've taken to solve the problem. 

https://www.movavi.com/photo-to-dvd-slideshow/formats.html
https://www.movavi.com/support/contact.html


 

 

Updating the graphics card driver
If you encounter an error message asking you to update your graphics drivers, you will need to download a new driver from your graphics
card manufacturer's website and install it on your system. Some graphics card drivers also have a useful utility that notifies you when a driver
update is available and updates the driver automatically. Keeping your graphics card drivers up-to-date will ensure stable performance of
applications and games on your computer.
 
Step 1: Find your graphics card manufacturer
1. Right-click your desktop and choose Screen Resolution
2. In the Screen Resolution settings window, click Advanced settings.
3. This will open your graphics card properties. At the top of the window, your graphics card model will be listed under the Adapter Type
section. Note the full name of the graphics card somewhere for later.
 
Step 2: Download the new version
Now that you've learned your graphics card manufacturer and model, go to the manufacturer's website and find driver downloads. There,
look for the model or series that you've found earlier and download the driver installation file. Some manufacturers may also offer a utility that
will automatically find the necessary driver.
NVIDIA download center
AMD download center
Intel download center
 

Warning:
Only download drivers from the official manufacturer's website. Third-

party websites offering driver downloads may contain malware.
 
Step 3: Install driver
Once the file is completely downloaded, run the installation file and follow the on-screen instructions to install the driver on your system. Your
display may blink several times in the process. After the installation has finished, it is advised that you restart the computer.
 

 
Updating NVIDIA® Driver
Modern NVIDIA graphics cards come with a special application called NVIDIA GeForce™ Experience that monitors driver updates and
allows you to optimize your computer's graphics performance.
 
1. Open the NVIDIA GeForce Experience application. It should already be installed on your system. If you cannot find the application,
please try the method above.
NVIDIA download center
 
2. In the Drivers section, click the Check for updates button to find the latest drivers.
 
3. When the application has found a newer driver, click the Download driver button. From here, the software will automatically download
and install the necessary driver for your system.

Updating AMD® or ATI® Driver
1. If you have an AMD or ATI graphics card, go to the Driver Download Center on AMD's official website.
AMD Driver Download Center
 
2. Download the auto detect utility and run it when the download has finished. 
Auto Detect Utility
 
3. The utility will then automatically find your graphics card and help you download and install the right driver for your system.
 
If the utility fails to find a driver for you, you can manually select your graphics card model and operating system on the Driver Downloads
page and download the driver.
 
4. After the driver has downloaded, run the installation file and follow the on-screen instructions to install it.
 

http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download
https://downloadcenter.intel.com/
http://www.nvidia.com/Download/index.aspx?lang=en-us
http://support.amd.com/en-us/download
http://www2.ati.com/drivers/auto/autodetectutility.exe


 

 

5. After the driver has been installed, it is recommended that you restart your computer.
 

If none of the above steps have helped, feel free to contact our support team via e-mail or live chat.
 
If possible, please include the name of your graphics card model (see Step 1), as well as screenshots of any error messages you have
encountered. This will help our support team specialists solve your problem quicker.

Glossary
The following is a list of some terms that you may come across while working with video and audio. You won't need to know all of these to
use Movavi software, but if you want to learn more about the specifics of media file processing, you can start here.
General
Aspect Ratio
A video's aspect ratio is the ratio of a video's width to its height in pixels. The two most frequently used aspect ratios are 4:3 and 16:9. The
former is used by most analog television broadcasts, while the latter, also referred to as widescreen – in films, DVDs, and modern HD video.
When the aspect ratios of your screen and a video do not match, you may notice black bars on two sides of the video.
 
Container Format (Video Format)
A container format is a file format for storing video or audio files that contains video and audio data in separate streams, as well as any other
associated data, such as subtitle tracks and additional data about the file. You can think of a container format as a box that holds together all
the parts that make up a video file, as illustrated below. The container format is what you usually see when you work with video files: you can
judge which format your video is in by the file extension: *.mp4 corresponds to MP4 format, *.mkv to Matroska format, etc. Since a container
format only 'contains' different video streams, it is possible that two files with the same format may have video streams encoded with different
codecs; therefore, one file may easily play in a player, while the other will not.

Codec
While a video file contains video and audio streams, these streams are in turn encoded using a video or audio codec that compresses the
data. You can think of a codec as a language: to play a video encoded with a certain codec, your player needs to be able to 'understand' how
it was encoded, so that it can decode or decipher the file. If your computer does not know how to decode a new codec, you can fix this by
converting the file to a different format or by installing a codec pack. However, please keep in mind that a lot of malware programs disguise
themselves as codec packs; you should only download codec packs directly from codec manufacturers or from trusted sources.
 
Bitrate
When referring to media, bitrate is the number of bits that is played back each second. The higher the bitrate, the more details that can be
conveyed with each second of the video or audio stream, and therefore, the higher the quality. There are two types of bitrate: constant bitrate
(CBR) and variable bitrate (VBR). Videos with constant bitrate, as you can probably guess from the name, have the same bitrate for each
and every frame of the video, no matter the complexity of the frame: simple frames, for example, those completely filled with black, have the
same number of bits as complex, colorful frames. This has a number of limitations, since the simple frames take up more bits than needed
to convey them, while complex frames are limited in quality. With variable bitrate, however, each frame is allotted only as many bits as it
needs, without limiting quality or wasting data. In most cases, we recommend that you use variable bitrate, however, you CBR is sometimes
useful for streaming media.
 
Frame Rate
The frame rate, or frames per second (FPS) is the number of video frames that is contained in a second of video. At low frame rates, you
may notice that the video is 'jittery', while higher frame rates produce a smooth high-quality video. Shooting videos at high frame rates (48 or
60 FPS) requires more resources and disc space, but you can easily slow down a high-FPS video to produce a slow-motion effect without
producing visual stutter. The industry standard for cinema frame rate is 24 or 25 frames per second, which is perceived as comfortable to the
human eye.
 
Interlaced Video, Deinterlacing Video
Video interlacing is a method used in traditional analogue video broadcasting that arose due to the limitations of early television. Each frame
of the video is split into half-frames, each frame containing even and odd rows consecutively. This allows to broadcast at double the frame
rate, producing a seemingly smoother video stream, while the eye does not notice the missing rows. However, on digital displays, interlaced
video may produce visible defects in the form of horizontal lines. Deinterlacing helps remove these defects using algorythms by merging the
two half-frames into one.
 
Remuxing
Many container formats support a number of common codecs, such as H.264, which can be stored in MP4, AVI, M2TS, MKV, MOV, and
other formats. When you convert a video that is encoded with a codec supported by both the input and output container formats, you can
simply transfer the video stream from one container format to another, without having to re-encode it. This process is called remuxing and it
allows you to save a lot of time, since video re-encoding is the longest part of the conversion process.
 
Resolution (Frame Size)
Resolution is the number of pixels that can fit inside the video frame. It is usually presented as "width x height" of the frame, for example,
1280x720 or 1920x1080. Sometimes, resolutions may also be referred to as "720p" or "1080p", by the number of pixels in a frame vertically.

mailto:support@movavi.com


 

 

At high resolutions, each frame is conveyed using more pixels, therefore allowing for more detail and higher quality, though taking up more
disc space. Whenever you convert a video to a lower resolution, you irretrievably lose some data, but if you convert a low-resolution video to
HD, the quality will stay the same.
 
Sample Rate
Sample rate, measured in Hertz, determines how many samples of digital audio are recorded each second. Higher sample rates allow to
record higher quality audio, although the files will take up slightly more space. The recommended sample rate is 44100 Hz, which is the
standard for audio CDs, delivering sound that covers the full range of human hearing. To reduce file size, you can convert audio with lower
sample rates, as low as 22 kHz, but keep in mind the quality deterioration. 
 
Subtitles
A subtitle is text that appears on screen (usually at the bottom) that reproduces the video's dialogue or presents additional explanatory text
and sound effects. Subtitles are frequently used by people hard of hearing, language learners, and when an audio translation is unavailable.
The subtitles may be embedded within the video container file (also known as softsub), saved as a separate file in *.srt, *.ass, *.sub, and
other subtitle formats, or drawn over the video stream in such a way that they cannot be disabled (hardsub).
 
Video Formats
Audio Video Interleaved – AVI (*.avi)
AVI is a multimedia container format created by Microsoft in the early 1990s. AVI supports multiple video and audio codecs and can contain
up to 16 audio and 16 subtitle tracks. While support for AVI is widespread on all operating systems, it is steadily being replaced by more
efficient formats.
 
DivX (*.divx)
DivX is a proprietary video format developed by DivX, Inc. Using its own codec, DivX allows for high compression rates while retaining high
quality. Sometimes the DivX codec is also used to encode video in AVI files. DivX is not supported by many media players, and requires a
codec pack to play. Movavi applications can open DivX files without any additional software.
 
Flash Video Format – FLV (*.flv)
Developed by Macromedia and currently owned by Adobe, FLV is frequently used for web video, as it is supported by most web browsers
and is accepted by most video sharing services and social networks. FLV can contain video encoded in Sorenson, FLV1, VP6 and H.264
codecs.
 
QuickTime – MOV (*.mov)
Developed by Apple, QuickTime is natively supported on Macs and iOS devices, so if you need to be sure that your video can be played on a
Mac, converting it to MOV would be a good idea. If you are preparing your files to also be played on a Windows computer, it's best to convert
it to MP4, as Windows computers need to download and install QuickTime from Apple's official website in order to play MOV videos.
 
SWF (*.swf)
Developed by Macromedia and currently owned by Adobe, SWF (formerly Shockwave Flash) is a video and graphics format related to Flash
video that can contain video, animations, vector images, and other content. Usually created in proprietary Adobe software, SWF files are
supported by Adobe Flash Player and most web browsers, which makes it an efficient way of sharing content online due to the small file size.
 
WebM
WebM is a free open-source container format developed by Google. It primarily functions as a widespread web video format that can easily
be embedded in HTML5 video tags. WebM can contain video encoded in the free VP8 and VP9 video codecs and Vorbis audio.
 
Movavi File Formats
*.mep, *.mep2, *.mepx
Used in Movavi Video Editor to create editing projects that store file references, order of files on the timeline, applied effects, and all other
work on the project. Please note that projects created in older versions may not be compatible with the most recent version of Movavi Video
Editor.
 
*.meps
Used in Movavi Slideshow Maker to create editing projects that store file preferences, order of files on the timeline, applied effects, and all
other work on the project.
 
*.mscproj, *.mrec
Used in Movavi Screen Capture to store temporary recording data, including the recording itself, as well as all settings used for the project.
 

http://www.movavi.com/videoeditor/
https://www.movavi.com/photo-to-dvd-slideshow/
http://www.movavi.com/screen-recorder/
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